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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground.

The TReK IONizer application provides the capability to start, stop, and monitor
Interplanetary Overlay Network (ION) software.

1.1 Getting Started

Start with the Introduction which provides an application overview. Next, try the Quick
Start Guides for “How Tos” for common functions. For help with details, reference the

Details section. See the FAQ and Troubleshooting section for helpful hints and solutions
to the common “‘gotchas”.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone:  256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time)
Fax: 256-544-9353

If you call the TReK Help Desk and you get a recording please leave a message and
someone will return your call. E-mail is the preferred contact method for help. The e-
mail message is automatically forwarded to the TReK developers and helps cut the
response time. The HOSC Help Desk (256-544-5066) can provide assistance as needed
and is available 24x7.

3 Introduction

The TReK IONizer application provides the capability to start, stop and monitor a single
instance of the Interplanetary Overlay Network (ION) software.

If you are not familiar with Delay Tolerant Networking or the Interplanetary Overlay
Network software, please see the TReK Delay Tolerant Networking Tutorial for an
introduction to these topics.
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4 Overview of the User Interface

4.1 Main Window

The main window (Monitor tab) is shown in Figure 1. The Monitor tab displays
messages written to the ION log and messages about ION processes.

TReK IONizer

File View IOM Options Help

10M Configuration Files: E Operational: . [ Start IOM ] [ Stop IOM ] [ Delete SDR.

Manitor Output
Time Category Message

Clear

b - -

Figure 1 Main Window (Monitor Tab)

The main window (Output tab) is shown in Figure 2. The Output tab displays messages
that ION writes to standard out (stdout). This includes 10N watch characters.

-
o _

B TReK IONizer = I

Eile View [OM Options Help

10N Configuration Files: E operational: [[l] | Startion | | stopion | | Delete soR

Output

f 10N Watch Characters

e _

Figure 2 Main Window (Output Tab)
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Figure 3 shows the IONizer console window. This window will only appear on
Windows. It will be displayed when you start the IONizer application. You can safely
iconify the console window to keep it out of your way. Please be sure not to close this
window, or it will shut down the IONizer application. You will not see this window if
you are running on Linux.

mi »

Figure 3 IONizer Console Window (Windows Only)

One of the ION configuration parameters provides the capability to run the Bundle
Protocol (BP) Echo Service. If ION is configured to run the BP Echo Service, the
console window shown in Figure 4 will be displayed when you start ION on Windows.
You will not see this window on Linux, even if ION is configured to run the BP Echo
Service. As noted in the window title, do not exit this window or it will shut down the

BP Echo Service.
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# | BP Echo Service: DO NOT EXIT

Figure 4 IONizer BP Echo Service Console Window (Windows Only)

When you stop ION on Windows, the BP Echo Service console window will close.
When you exit the IONizer application on Windows, the IONizer main window and
IONizer console window will both close.

Toolbars
The toolbar provides the capability to specify ION configuration files, start ION, stop
ION, and delete the ION SDR.

4.2 Menus

The application menus are: File, View, ION, Options, and Help. Each of these menus is
described in more detail below.

File Menu
The File menu provides the capability to exit the application.

View Menu
The View menu provides the capability to clear the main window message area and show
and hide the main window message area.

ION Menu
The ION menu provides the capability to specify ION configuration files, start ION, stop
ION, and delete the ION SDR.

Options Menu
The Options menu provides access to the Messages dialog. The Messages dialog

displays application messages.
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Help Menu
The Help menu provides access to on-line help and application version information.

5 Quick Start Guides
This section provides “How Tos” for common functions.

5.1 Howto Start ION
The following steps explain how to start ION.

1. ldentify the location of the ION configuration files using the field provided in the
toolbar. You can use the TReK IONconfig application to create a set of ION
configuration files.

2. Use the Start ION button in the toolbar to start ION (see Note 3 below for important
information for ISS users). As the ION processes start, you will see status messages
in the main window.

Note: If one or more of the required 10N processes fail to start this will be reflected in
the status messages. If this occurs, you will need to stop ION and review the ION log to
determine what has gone wrong. The ION log is located in the same directory as the ION
configuration files and shown in the Monitor tab. If you need to ensure ION is
completely cleaned up you can go to a command prompt window and type ‘killm’. This
will clean up all instances of any ION processes on the computer. Use caution when
using killm.

Note 2: The ION configuration files must be located on a local drive. Ifyou attempt to
use ION configuration files located on a shared drive, this can cause the IONizer
application to crash.

Note 3: When connecting to the HOSC DTN ground gateway for ISS, a dialog box with
three options will appear. Each option is explained below:

» Auto reconfiguration — This is the recommended option. It will automatically
reconfigure 10N to match the information provided by the HOSC DTN ground
gateway using a series of scripts and the ION configuration files.

> ION as configured — This option will run with the ION configuration files as is.
This allows users to configure 10N completely as needed, but may require
periodic changes to the ION configuration files.

» TReK DTN proxy — This option uses the original TReK DTN proxy. The
information provided by the HOSC ground gateway is used to configure a TReK
provided application that will bridge the local ION instance with the HOSC DTN
ground gateway.
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5.2 Howto Stop ION
The following steps explain how to stop ION.

1. Use the Stop ION button in the toolbar to stop ION. As the ION processes stop, you
will see status messages in the main window.

5.3 How to Delete the ION SDR
The following steps explain how to delete the ION SDR.

1. Use the Delete ION SDR hutton in the toolbar to delete the SDR. ION will be
stopped and the SDR will be deleted.

Note: Be aware that deleting the SDR will delete all data ION was storing in preparation
for transmitting as well as partially received data.

5.4 Howto Clear ION Log and Process Status Messages
The following steps explain how to clear ION log and process status messages.

1. Use the Clear button located on the Monitor tab. Once the messages are cleared,
there is no way to recover them.

5.5 Howto Clear ION Output Messages
The following steps explain how to clear ION output messages.

1. Use the Clear button located on the Output tab. Once the output is cleared, there is no
way to recover it.

6 Details
This section covers various application details.

6.1 1ON Watch Characters
The 1ON Watch Characters dialog contains two tabs: All and Summary.

6.1.1 All Tab

The All tab is shown in Figure 5. The All tab provides a list of all the ION watch
characters, the protocol associated with the watch character, and a short description.
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E IOM Watch Characters

7 |- |

All Summary

Character Protocol Description

a BP Mew bundle is queued for forwarding.

b BP Bundle is gqueued for transmission.

c BP Bundle is popped from its transmission queue,

d LTP Bundle appended to block for next session,

e LTP Segment of block is queued for transmission,

f LTP Block has been fully segmented for transmission.

g LTP Segment popped from transmission queue.

h LTP Positive ACK recerved for block, session ended.

] BP Bundle is placed in "limbo" for pessible future re-forwarding.

k BP Bundle is removed from "limbe” and queue for re-forwarding.

m BP Custody acceptance signal is received,

P CFDP CFDP PDU transrmitted.

q CFDP CFOP PDU received.

5 LTP Segment received,

t LTP Block has been fully received.

w BP Custody of bundle is accepted.

X BP Custody of bundle is refused,

¥ BP Bundle is accepted upon arrival,

z BP Bundle is queued for delivery to an application,
| @ LTP Megative ACK received for block, segrments retransmitted.

= LTP Unacknowledged checkpoint was retransmitted.

+ LTP Unacknowledged report segment was retransmitted.

{ LTP Export session cancelled lecally (by sender).

} LTP Import session cancelled by remote sender.

[ LTP Import session cancelled locally (by receiver).

] LTP Export session cancelled by remote receiver,

~ BP Bundle is abandoned (discarded) on atternpt to forward it.
' ! BP Bundle is destroyed due to TTL expiration,

& BP Custody refusal signal is received,

# BP Bundle is queued for re-forwarding due to CL protocol failure,

Figure 5 ION Watch Characters Dialog (All Tab)

6.1.2 Summary Tab
The Summary Tab shows summary information about the ION watch characters selected
in the Main Window Output tab. The Summary Tab will be empty if you have not

selected any ION watch characters in the Main Window Output Tab. Figure 6 shows the
Main Window Output tab with some ION watch characters selected.
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B TReK IONizer

Eile View [OMN Options Help

10N Configuration Files:  D:jontest\node_1} E] operatonal: [l | startion | | stopion | | Delete sDR

Manitor Output

1 file(s) copied.
[l admin pam using SDR. parm overrides from start.ionconfig.

wmkey: 55281
wmSize: 5000000
wmAddress: i}
sdriMame: ‘ion’

sdritmSize: 1000000
configFlags: 3

heapWords: 250000 i
heapkey: -1 I
logSize: a

logkey: -1
pathMame: 'D:Yonrun’
Stopping ionadmin,

Waiting for 1 seconds, press CTRL+C to quit ...00
Stopping ionsecadmin,

Waiting for 1 seconds, press CTRL+C to quit ...00
Stopping bpadmin,

Waiting for 1 seconds, press CTRL+C to quit ...00
Stopping ipnadmin.

Waiting for 1 seconds, press CTRL+C to quit ...00
Stopping cfdpadmin.

f Waiting for 1 seconds, press CTRL+C to quit ...00

Waiting for 1 seconds, press CTRL+C to quit ...00
] abwcpabwpabwopabwed

10N Watch Characters

L% -

Figure 6 Selected ION Watch Characters

Figure 7 shows what the Summary tab will look like when it is populated after you select
ION watch characters in the Main Window Output Tab and push the ION Watch
Characters button. This information can be helpful when debugging.
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'3 |
E IOM Watch Characters @I&J

- Summary
Character Count Protocol Description
a 4 BP Mew bundle 15 queued for forwarding.
b 4 BP Bundle is queued for transmission,
c 4 BP Bundle is popped from its transmission queue,
p 4 CFDP CFDP PDU transmitted.
w 4 BP Custody of bundle is accepted.
||
L]
] N

Close

e L1 [

Figure 7 ION Watch Characters Dialog (Summary Tab)

6.2 Application Settings

The IONizer application saves some settings as application settings each time you exit
the application. The next time you run the application, the application will initialize with
the previous application settings. The following application settings are saved:

> Application Window Size
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> ION Configuration Files Directory

7 FAQ and Troubleshooting

This section addresses Frequently Asked Questions and provides tips for troubleshooting
common gotchas.

7.1 What is ION?

The following text is from the Interplanetary Overlay Network (ION) documentation:

“The Interplanetary Overlay Network (ION) software distribution is an implementation of
Delay-Tolerant Networking (DTN) architecture as described in Internet RFC 4838. It is
designed to enable inexpensive insertion of DTN functionality into embedded systems such
as robotic spacecraft. The intent of ION deployment in space flight mission systems is to
reduce cost and risk in mission communications by simplifying the construction and
operation of automated digital data communication networks spanning space links, planetary
surface links, and terrestrial links.

A comprehensive overview of DTN is beyond the scope of this document. Very briefly,
though, DTN is a digital communication networking technology that enables data to be
conveyed between two communicating entities automatically and reliably even if one or more
of the network links in the end-to-end path between those entities is subject to very long
signal propagation latency and/or prolonged intervals of unavailability.”

7.2 What should I do if there are errors when | start ION?

Review the messages in the IONizer main window and the ION log file. The ION log
file will be located in the directory with the ION configuration files. Some common
problems that can occur:

a. The local IP Address has changed. If you started ION using an existing SDR file that
contained an old IP address this can cause problems. If this occurs you will need to
decide whether to modify the SDR via ION provided administrative programs to
update the IP address or to delete the SDR (losing any data stored in the SDR).

b. The ION configuration files contain information that is incorrect (such as an IP
address) or missing information.

Note: When using the TReK IONconfig application to create ION configuration files it is
important to ensure the entire diagram (all nodes and ducts) contain valid information or
at least no conflicting information. For example, if you use the same local IP address and
port 4556 for all nodes in the diagram this will cause an error when you try to start ION.
The nodes either need to use different IP addresses or different ports. Even though you

10
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may only be using the configuration files for one of the nodes, the ION configuration
files contain many interrelated parameters that are derived from information across the
entire diagram.

11



